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Software Introduction 

 

Cube-manager is a software, part of the Cube-suite by Stonex Srl. It offers tools for the 

transferring and processing of data from GNSS receivers and total stations. The program 

consists of a series of general functions that represent the core and 4 specialized modules 

that provide accurate and complete commands dedicated to 4 processing that are 

commonly performed on surveys. 

 

The P module is about Post-processing. This module is subdivided into 5 commands: Stop 

& Go, Kinematic, Static with single base, Static with multiple base and Network adjustments. 

 

The T module is named after Topography, in this module all the most topographic functions 

are included, such as the roto-translation, the coordinates conversion or the geo-referencing 

of raster files. 

 

Module M concerns Modeling, this package proposes calculation functions such as 

triangulation and contour lines. 

 

Module F concerns Photogrammetry, at the time of which we write, this module is not yet 

designed. 

 

The purchase of a module will give the possibility to access the general functions of the 

program as well as of course the additional functions included in the package. You can use 

a reduced and free version of the functions of this program by downloading the Cube-link 

software that is also part of the Cube-suite by Stonex Srl. 

 

The application has a modern Microsoft interface and implements a CAD, easy to use and 

flexible, which allows you to view data in both 2D and 3D. It offers functions for graphical 

and tabular displaying of raw data and results; some COGO commands; functions for 

importing and exporting data, using standard file formats such as DXF or CSV and manages 

the most common vector entities (lines, polylines, circles, arcs, texts, ...). 

 

The Cube-manager also supports a special point entity called the Topographic Point. 

Topographic points are the fundamental parts of each survey and are generated by 

importing data or using specific tools. These must be considered as a data structure that 

contains all the information acquired during the topographic survey, even if obtained from 

multiple surveys of the GNSS or TPS type. For example: importing a GNSS survey generates 

topographic points that will be represented by symbols and with different graphic 

properties. These must be considered as a data structure that contains all the information 

acquired during the topographic survey, both relative to the position, such as coordinates 

(east, north, height, latitude, longitude, elevation) but also related to accuracy and control 

(e.g. Residuals), and information on working methods (e.g. RTK differential correction). 
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1 Installing and uninstalling Cube-manager 
 

1.1 Cube-manager installation 

 

To install the program, select the language, read and accept the user license agreement; 

select the folder for the location of the shortcuts and eventually set any link to the program 

from the desktop. Before you click the install button you can check and change the 

program's folder location, the start menu and the folder. 

 

The setup is available for 32-bit and 64-bit platforms. 

 

Once the installation is completed, the first time you launch the program you will be asked 

to enter the code. Just enter your data in the form fields (Figure 1.1) following the 

instructions on the screen. 

 

If you are not online at the time of the registration, simply contact by phone (or fax) the 

Stonex Srl and communicate the code that will appear on the screen (SERIAL NUMBER) 

together with the purchase code and user data for registration. 

 

1.2 Cube-manager uninstallation 

 

To uninstall, go to the folder where the program is located and press the uninstall button 

that will execute the operation. 

 

 
Figure 1.1 
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2 General functions 
 

2.1 File (tab) 

 

File is the first tab and is located at the top left of the main screen. This section contains 

many utility commands, including one for settings, and for import and export operations 

(Figure 2.1). The commands at the bottom provide general information: by clicking the 

Release notes command, you can access the file with a summary of all the information 

concerning the new versions and the updates of the program; Online Manual is the 

command that opens the PDF of the User Manual; Information opens the general 

presentation window of the software, where you can see the installed version number and 

the active module or modules. 
 

 
Figure 2.1 
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2.1.1 Create, open and save jobs 

 

Cube-manager files have *.cubemgr extension and contain all the CAD and topographic 

entities used during processing. When you want to create a new job, the application asks if 

you want to create a new blank job with default variables or if you want to proceed with a 

new job with variables from template files, it is in fact possible to save template files ( with 

extension .cubemntl) that contain all the settings used for a project (variable dimensions, 

parameter settings, levels, etc.). 

 

If you want to open a file in memory, the supported extensions will be those related to the 

project file of the Cube-manager program, the automatic save file (.cubemnbk) and for 

compatibility the projects and saving extensions of the Cube-link program will also be 

recognized. 

 

Saving jobs will include the possibility to save a project file or a template file. 

 

Recent projects are saved in a list in the File menu (Recent projects command). Selecting a 

project from this list and hovering the mouse over will display a preview of the job graphics. 
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2.1.2 Imports 

 

Cube-manager allows you to import files in different formats, including the Cube-a format. 

To import, just select a format from the list shown in the Import menu (Figure 2.2), each 

choice will open a new window (for details refer to the paragraphs related to the different 

imports). 

 

 

 
Figure 2.2 

 

 

Figure 2.3 
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2.1.2.1 Import Cube-a 

 

To import a Cube-a file you can select the relevant command in the File tab or you can click 

on the Cube-a import icon in the Home tab (Figure 2.3). In case of importing Cube-a files, 

the system can operate on single files or on files that are in specific folders. The second case 

occurs when the user has access to the entire Cube-a project folder and selects the file with 

the extension .pd contained in it. 

In Cube-a, a job is stored in a folder that has the same name of the project and has subfolders 

containing all the data; the file to be imported is in the subfolder called "Data". 

Copying the entire project folder allows the program to access data files such as photos and 

reference system information. Within Android devices, projects are always stored as 

subfolders of the "StonexCube/Projects" folder. 

Figure 2.4 shows the main screen for exporting a Cube-a file. After selecting the file, a 

reference system must be set up before proceeding. You can use the reference system 

previously defined in the Cube-manager (at start-up the program will automatically always 

check if a default reference system has been set) or you can use coordinates defined in the 

field. In addition, you can set up a local system or a default reference system, in which case 

the program will allow you to access the relevant windows for the settings. 

 

If there are photos in the file, you can transform them into GeoTIFF. 

 

For leap seconds a default value is proposed which can be changed during the import phase. 

 

 
Figure 2.4 
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2.1.2.2 Import RW5 

 

To import an RW5 file you can select the relevant command in the File tab or you can click 

on the Import RW5 icon in the Home tab (Figure 2.3). You will see a window as in Figure 2.5, 

where you can specify the name and path of the file you want to import. A useful feature is 

the ability to select the CRD file and then import only the updated data found in the field (if 

you import raw files, the option on CRD files will not be visible). 

 

Also, for this type of import the coordinates can be changed by selecting a local system or 

a predefined system, or leave the coordinates defined in the field or use the default reference 

system (set by the user when the program starts). 

 

If you want to use the USB connection to import, click on Connect USB (the connection is 

possible using the Windows Mobile Device Center program). The device used in the field 

can be connected directly to the PC and through the window in Figure 2.6, it is possible to 

directly download the files from the portable device to the PC or vice versa. By default, the 

program always shows the folder with the recorded data, but this position can be modified 

at will, clicking on the search button, you can then view the internal structure of the device 

and select the desired folder. 

 
Figure 2.5 
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Figure 2.6 
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2.1.2.3 Import Geogis 

 

To import a Geogis file, you can select the relevant command in the File tab or you can click 

on the Import Geogis icon in the Home tab (Figure 2.3). 

If there are photos in the project, they can be transformed into GeoTIFF files. Furthermore, 

even for GeoGis files it is possible to connect a device to the PC via the USB connection (with 

the same logic and functionality illustrated in the paragraph concerning the importation of 

RW5 files). 

 

With the USB connection even Raster, DXF and ESRI Shapefiles can be copied to the PC. To 

do this, simply select the format chosen with the drop-down menu command at the top of 

the screen. 

For this format as well, it is possible to import the coordinates surveyed in the field or use 

the default reference system, a local system or select a Datum. In the last two cases you will 

have the possibility to access windows where to set the characteristics of these systems. 

 

2.1.2.4 Import ASCII 

 

To import a text file, you can select the relevant command in the File tab or you can click on 

the Import ASCII icon in the Home tab (Figure 2.3). This function consists of 3 steps. 

In the first step (Figure 2.7), you must select the file to be imported indicating name and 

path, in this phase you can also edit the file by clicking on the Edit file button (this will open 

a simple text editor where you can change the file and to show/hide the number of lines). 

Before proceeding with the import, it is necessary to select whether to create topographic 

points or CAD points from the imported file. You can set the encoding of the file (UTF-8 is 

the default choice). 

 

In the step n. 2 (Figure 2.8) you can choose between a default file format or a custom format 

(Figure 2.9). For the second type of format it will be necessary to enter a name and set the 

separator character. The inserted custom formats can also be deleted using the Delete 

selected command located on the right, next to the drop-down menu for selection. 

For all formats, you need to set the unit of measurement for the reading of geographical 

coordinates (latitude, longitude, elevation) and the line from which to start reading the file 

(to exclude the heading). 

 

In the step n. 3 (Figure 2.10), for custom formats it is possible to assign the type of content 

(Point name, Easting, Northing, Elevation, Latitude, Longitude, Ellipsoidal h., ECEF X, ECEF Y, 

ECEF Z, Description, Code) to each column (click on the heading to view the list). This will 

save the new format with the fields selected, the created formats cannot be overwritten. 

When importing geographical coordinates, the program will automatically allow the 

selection of a reference system. 
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Figure 2.7 

 
Figure 2.8 
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Figure 2.9 

 
Figure 2.10 
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2.1.2.5 Create map 

 

To create a map, you can click the Map from web button on the File tab or you can click on 

the Create Map icon in the Home tab (Figure 2.3). 

This function imports a map into the project, it will require the East and North coordinates 

that you want to set as the center of the map. You will then see a window powered by Google 

Maps as in Figure 2.11. To import the map into the CAD you will need to save the image as 

jpeg. The services for creating maps are two: Google and Bing. The window and the creation 

occur, in both cases, in the same way. If the created images do not cover the area in which 

you want to create the map, you can increase the horizontal and vertical images, or you can 

proceed to create a new map in addition to the one created. The program will overlay the 

geo-referenced images. 

The images downloaded using these services are subject to copyright and in the case of 

Google maps it is possible that after a quantity of free downloads the service requires a 

payment. 

 

 

 
Figure 2.11 
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2.1.2.6 Send to AutoCAD 

 

To send CAD entities or raster images to AutoCAD, click the Send to AutoCAD icon (Figure 

2.3). It is essential, for a successful communication between Cube-manager and AutoCAD, 

to set (in the general settings of the program, illustrated below) the version of the AutoCAD 

program installed in the PC, and it is necessary that both programs are running. 

 

2.1.2.7 Print 

 

The Print command generates a window that includes three tabs: Print settings; Printing 

styles; Printing tables. Print Settings (Figure 2.12) is the tab where you can set the printer 

you want to use and the page you want to print. Even the scale, origins, print area and print 

size can be set in this section. 

 

In the Printing Styles tab, you can set the thickness, terminations and joints, using the layer 

settings or creating new styles. You can also import previously saved styles or save new ones 

(Figure 2.13). 

 

The last tab Printing tables is dedicated to saving, deleting or loading print tables. In each 

of the tabs just described, you can click on the print preview button (Preview and print) to 

see a layout of how the file will be printed.  
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Figure 2.12 
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Figure 2.13 
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2.1.2.8 DXF/DWG 

 

This function allows the system to import the graphic elements as they are and since there 

are no topographic points in this type of file it is possible to force this choice, so that the 

entities with attributes become topographic points (Figure 2.14). 

If you decide to import by transforming the points into topographic points, you will have 

the possibility to establish the name (sequential) of the points and the properties of the 

imported block. You can also select the option to import points on a single layer, in this case 

the current project layer will be selected. 

 

 
Figure 2.14 

 

2.1.2.9 Pregeo 

 

The program supports the processing of Pregeo files, but this function is only visible in the 

Italian version. To access it, just set the Italian language from the change languages button. 
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2.1.2.10 Digital map extract EMP 

 

It is possible to import a file with the .EMP extension simply by indicating the name and path 

of the file from the screen that will be generated by clicking on the EMP Digital Extract 

command from the File tab (example of a project with imported EMP extract Figure 2.15). 

This is a Pregeo function (italian). 

 

 
Figure 2.15 
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2.1.2.11 ESRI Shapefile 

 

 

The import of a shapefile generates a screen like the one in Figure 2.16. Clicking Open at the 

top right you will see a preview of the work you are importing, on the left you will see the 

layers that make up the file. By clicking Import you can finish the preview and re-enter the 

graphic view in the main window. 

 

 
 

Figure 2.16 
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2.1.2.12 Features of GPS points 

 

Whenever you decide to import GPS points into the program, Cube-manager will 

automatically display a screen, as shown in Figure 2.17. 

From this window it is possible to set the graphic appearance of the points, subdividing them 

according to the type of solution that characterizes them. It will then be possible to set the 

layer, the color and the icon of the symbol, divided by type of points. The size of the symbol, 

the font and its color can be set for the total number of points that are being imported. 

Note: GPS stations are by default positioned on a non-visible layer, however it is always 

possible to reactivate the layer, and set the color and icon of the symbol. 

 

 
Figure 2.17 
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2.1.3 Export  

 

Cube-manager supports various export formats, in Figure 2.18 all possible exports are 

summarized. To access the exporting in various formats, click on the Export command in the 

File tab (Figure 2.1). 

 

 
Figure 2.18 
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2.1.3.1 Export Cube-a 

 

To export in Cube-a format, simply select the name and path of the file to be created, by 

default the program exports both graphical entities and topographic points. However, it is 

also possible to exclude graphical entities and to export only topographic points (Figure 

2.19). 

 

 
Figure 2.19 
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2.1.3.2 Export RW5 

 

To export in this format, you must select a file name and path, optionally you can also create 

an EzSurv file, you will always need to select a file name and path. You can also create a CRD 

file associated with the created RW5 file (Figure 2.20). 

 

 
Figure 2.20 

 

 

2.1.3.3 Export GeoGIS 

 

The export of a GeoGIS file is like the export of a Cube-a, it will be necessary to set a file 

name and a path. By default, both points and graphic entities are exported, but it is always 

possible to exclude the graphic entities from the export. 
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2.1.3.4  DXF/DWG file 

 

This export is the only one that can be recalled from two different commands within the 

program. First command is into the menu in Figure 2.18, like all other exports, the second is 

the Dxf/Dwg Out command in the Home tab (Figure 2.3). 

For a correct exporting, the first choice to make is the version of AutoCAD® that you want 

to use to create the file. Then you can select the options on the entities, especially if you 

want to include Raster images, backgrounds and topographic points. 

If you export the points as INSERS, you must indicate which attributes you want to define 

for the points and how you want to get them, for example if you want to get them from the 

point label. If simple topographic points are chosen, not as INSERTS, the section on the right 

called Options for displaying points will be enabled. In this section it is possible to set the 

size (as an absolute value, as 5% of the drawing area or as a percentage of the drawing 

window) and the symbol for displaying points in AutoCAD® (from the drop-down menu in 

Figure 2.21). 

In the general options section, you can enter the text size and choose to create a 2D DXF file 

(Figure 2.21). 

 

 
Figure 2.21 
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2.1.3.5 Export on text file 

 

To create a text file just click on the Export points to text file button (Figure 2.18). The creation 

of the file is customizable, and it is possible to define the characteristics that you want to 

give to it: you can choose whether to include a header, the data to be inserted, the separator 

character, the format of the geographical coordinates etc. 

 

 
Figure 2.22 

 

2.1.3.6 Export an image file (bmp, jpg, etc.) 

 

You can export an image of the planimetric (or 3D) view of the program, just click on the 

corresponding command from the menu in Figure 2.18 and set the width in pixels of the 

image you want to create. 
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2.1.3.7 Export in Google (KMZ) 

 

By accessing the Export to Google (KMZ file) function, you can generate a KMZ file that can 

be viewed in Google Earth, this export is possible only if there is a fieldbook in the current 

job. The procedure is like the other exports of this application; first specify a name and a 

path for the file, then proceed with selecting the features you want to add. The structure of 

this window is very flexible because you can indicate which data to export; including CAD 

elements, GPS data, photos, database attributes. As soon as the file is created, the program 

will ask if you want to load it directly in Google Earth (Google Earth must have been 

previously installed in the PC). 

 

2.1.3.8 ESRI Shapefile (shp) 

 

The steps for creating an ESRI shapefile file (Figure 2.23) are like those applied to the export 

of other formats, once selected the name and location of the file to be exported, you can 

select a series of information and contents that you want attribute to the file. 

 

 
Figure 2.23 
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2.1.4 Settings 

 

In Settings (command in the File tab), you can set the general program functions, such as 

checking for updates at startup or the version of AutoCAD® to be used (Figure 2.24). This 

function consists of 4 tabs that will be discussed below. It will allow you to completely 

customize the aesthetic, functional and practical aspects of the program. Note: to make sure 

that the changes are effective, after changing the settings, it is advisable to restart the 

program. 

 
Figure 2.24 

 

In the Appearance tab (Figure 2.25) you can determine, for example, the background color 

of the work area or enable dynamic information on the cursor. 

Among the other functions available there is the possibility to enable/disable the dynamic 

list of features, the display of the thicknesses on the screen, the size of the Cartesian axes’ 

icon. 
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By enabling the dynamic list of features, you can read the characteristics of the elements in 

the project. If you hover the mouse over the elements, the application will display a popup 

window, like the ones below (Figure 2.26), which will describe the type element and its 

characteristics. 

 

 
Figure 2.25 

 

  
 

Figure 2.26 
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The Help tab (Figure 2.27) is useful for setting the use of the Object Snap and in which mode 

and whether to enable or disable polar pointing and Ortho mode. Furthermore, in this 

section it is possible to customize the size of the Osnap symbol and the size of the selection 

area when this mode is active. 

 

 
Figure 2.27 

 

In the System tab it is possible to set the topographic unit of measure and the decimal 

figures for the display of parameters such as heights, coordinates, distances, etc. 

Regarding the representation of the angles, which is a setting in this section, there are two 

possibilities: the representation of the topographic angle and GPS and the representation of 

the general angle, which concerns the graphics. The representation of the angle relative to 

the topography is set by default in Grads but when a fielbook is imported, the application 

will read the configurations of the job and set the representation accordingly. 
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From the File tab you can click on the Set Graphic Styles command to access the menu in 

Figure 2.28. 

 

 
Figure 2.28 

 

Each of the commands in this menu generates a window for customizing lines, hatches, point 

symbols, printing styles and dimensions (in Figure 2.29 an example of a window for 

customizing lines). 

 

 
Figure 2.29 

From the File Tab it is also possible to access the Upload utility files function which has the 

purpose of uploading files of three categories (Figure 2.30): image files, database files, 
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geoids (Cube-manager supports all major geoid formats: GGF Files; UGF Files; GEO Files; 

GRD Files).  

  

 

 
Figure 2.30 

 
Figure 2.31 

 

You can check how many and which fieldbooks are present in a job by accessing the 

Fieldbook List function. In Figure 2.31, the information displayed is: the name of the 

fieldbook, the type, the number of stations and the number of points. The operations that 

can be performed are to change the visibility of the fielbook (by clicking on the light bulb 

icon on the left) and to delete the fielbook. By deleting a fieldbook it is also possible to 

delete the topographic points contained in it. 

 

The last two commands in the File tab are: Check for updates and Activate Cube-manager. 

The first command is for manually check if program’s updates are available. Every time the 

application is started, an automatic check will be carried out to check the availability of new 

updates (default choice, it can be changed from the Settings section). However, you can also 

manually check for updates by clicking the button described above. If an update is available 
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and you decide to download it, the program will ask you to select in which folder you want 

to save the executable file, after which the download will start automatically. 

The Activation Cube-manager button allows access to the screen in Figure 1.1, described in 

paragraph 1. 
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2.2 Home (tab) 

 

The Home tab is located at the top of the main screen and contains several sections (Figure 

2.32), including the In/Out section (Figure 2.3) described in paragraph 2.1.2, which contains 

all the formats available for import into the program. 

 

 
Figure 2.32 

2.2.1 Zoom, Clipboard 

 

The Zoom section contains numerous commands for zooming and selecting items in 

graphics. The commands are: Limits, Window, On point, Magnifier and Zoom that allows you 

to access a submenu to select the zoom in, zoom out or dynamic pan of the graphic (Figure 

2.33). In the Clipboard section you can find the classic copy-paste function. 

 

 

 
Figure 2.33 
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2.2.2 Layer 

 

The Layer section is used to manage the various layers in the project. By clicking on the 

Modify button (Figure 2.34, red circle), you can access the window in Figure 2.35, where you 

can operate on layers with visibility, selection or block functions. 

Layers can also be managed via the Layer Properties Management window, which can be 

accessed by clicking on the related icon on the main screen (Figure 2.36). In the layer 

properties window (Figure 2.37), you can create new layers and delete others (in order to 

delete a layer this must not be used and deselected, a layer is not used when it does not 

contain graphic elements or topographic points). 

This window displays all the available layers and their classic characteristics, such as color 

and type of line, from here you can print the contents of a layer and decide whether to show 

the names and symbols present (by clicking on the eye icon). You can also operate on 

visibility (light bulb icon). 

 

 
Figure 2.34 

 
Figure 2.35 

 

 
Figure 2.36 
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Figure 2.37 
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2.2.3 DB 

 

The Database command is divided into two commands: Database management and 

Load/Add Database. The Database management command, if clicked opens a screen as in 

Figure 2.39, from here it is possible to compose a database (for GeoGIS), as a set of records 

and lists of attributes (as you can see in the example for the BUILDING object you have the 

attributes: ‘type’ with the relative list - commercial, industrial, residential, warehouse; ‘street 

code’; ‘heating system’ with relative list -autonomous, centralized etc.). 

The screen is divided into two areas, on the left you can check the structure of the database; 

the underlying commands are for opening, creating, saving the database, undo and redo, 

and the reordering of the elements in the database structure. The sector on the right is a 

convenience window for importing information from the text file or from a default list (by 

clicking the blue document icon) to compose the database structure. The Set DBF command 

opens a screen where it will be possible to assign the type to the new attribute (as for 

shapefiles: Text, Numerical integer, Numeric decimal, Boolean, Date), the same screen is 

opened automatically even when a new database is saved. 

 

To create a new database, after clicking the create button, you can write in the left area of 

the main screen, press TAB to create a new field for the records, press ENTER for a new 

attribute field (press TAB twice to edit the attribute’s list). With the right-click on the grid 

you can access a popup menu that offers all the commands for creating and writing the 

database. 

With the right-click on the right grid, you can access a popoup menu with commands to 

manage any imported template files. 

You can save and view the database on a device connected via USB to the Windows Mobile 

Device Center, the device must be equipped with the GeoGIS program and during the 

transfer the GeoGIS program must not be running (Cube-manager always generates a 

backup copy of the database in memory in the device). 

 

The Load/Add Database command leads to a window as in Figure 2.38, with this command 

it is possible to upload one or more databases in the current job (the databases to be 

uploaded must be available in the program. To load the databases in memory, from the File 

Tab access the Load utility file function, and then click on Upload database file). In the table 

on the left are summarized the databases available in memory, to upload the database just 

click on the bottom, on the Load selected attributes, in the table on the right will appear the 

loaded databases. 
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Figure 2.38 

 
Figure 2.39 
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2.2.4 Language 

 

By pressing the language button, you can select the language of the program. We 

recommend restarting the program after changing the language. 
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2.3 CAD (tab) 

 

By clicking on the CAD tab (Figure 2.40), it is possible to access the area dedicated to design 

and CAD processing, which aims to support and integrate the topographic elements. 

These functions are like AutoCAD® ones and its many clones. This section is divided into 

two parts: draw and modify. In the Draw section (Figure 2.41) you can find commands to 

draw CAD entities such as lines, polylines, polygons and so on. Once you have selected the 

element you want to draw, just follow the instructions (represented by the suggestions that 

will appear on the screen and/or before the command line) to complete the command 

(Figure 2.42, example of a suggestion on the screen for drawing a line; Figure 2.43, example 

of a suggestion before the command line). 

Often, with the suggestions before the command line at the bottom left of the main screen, 

other subcommands are available (to the right of the command line). When the 

subcommands are visible, to use them just write them in the command line and click on 

enter (or simply click on them). 

The subcommands are very intuitive to use, however there is a command that is worth 

analyzing, the ‘pro’ command for properties (Figure 2.44, second command from the right). 

This command opens the Quick entities selection window (Figure 2.45), which consists of 

two tabs. The first tab called ‘CAD entities’ allows you to select entities by referring to one 

feature or another, e.g. color and type of line. The second tab is called ‘Topographic Points’ 

and allows you to select the points based on their characteristics. As you can see in Figure 

2.46 a wide range of attributes is available, from points with a given point symbol to point 

in the same fieldbook. 

 

 

 
Figure 2.40 

 

 
Figure 2.41 
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Figure 2.42 

 

 
Figure 2.43 

 
Figure 2.44 
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Figure 2.45 
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Figure 2.46 

 

The commands in the Draw section can be used with OSNAP (object snap) functions, such 

as OSNAP on the ends or midpoints. Note that by default the program starts with an OSNAP 

active on the ends. This setting can be changed at any time by clicking on the Osnap (on/off) 

button at the bottom of the main screen, shown in Figure 2.47 in dark gray (active). 

All the OSNAP modes are represented by the icons in Figure 2.48, passing with the mouse 

on them you will see a suggestion on the functionality of the command. 

 

 
Figure 2.47 
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Figure 2.48 

In the Modify section of the CAD tab (Figure 2.49), you can find all the functions for 

processing CAD entities. The names and the icons of the commands are very intuitive, and 

each command has a tooltip that briefly explains what its functionality is. Among the 

available commands there are explode, group, ungroup; these commands are useful for 

working with CAD entity groups. The Cut box window command generates a window as in 

Figure 2.50, where it will be possible to create a new job by selecting a portion of the window 

of the current job, the cutting window can have an outer frame with customizable 

customizable graphic characteristics and layers. 

 

The Properties button generates a window that summarizes the properties of the selected 

entity, the system recognizes what type of entity it is and at the bottom it shows this 

information (Figure 2.51, in this case it is the properties of a polyline). 

 

There is also a command to copy the properties of one entity on another and a command 

to change the order in which the drawings are displayed. 

 

 
Figure 2.49 
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Figure 2.50 
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Figure 2.51 

 

Figure 2.52 shows a popup window related to the Edit poly command. The submenu contains 

commands for modifing the polylines, for example by inserting a vertex or by removing it. 

The use is very simple and, like any other CAD command, just follow the suggestions that 

appear on the screen. 

 
Figure 2.52 
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2.4 Measures (tab) 

 

The functions in this section (Figure 2.53) are used to calculate and display information on 

surveys’ data. This section is divided into three areas below: Measure, Calculations, 

Dimensions. 

 

 
Figure 2.53 

 

The Coordin. button will give the possibility to choose a point and then show the Cartesian 

coordinates (with the addition of the height) of that point, as shown in Figure 2.54. 

 

 
Figure 2.54 

The Distance will give the possibility to select two points and measure the distance between 

them. The information provided by this function is the 3D distance, the horizontal distance, 

the components along the three axes, the azimuth angle and the zenith angle (the graphic 

appearance of this information is like that one shown for the Coordin command). 

 

The Angle button will give the possibility to select 3 points: the start point, the midpoint and 

the end point. This function will calculate a clockwise angle and a counterclockwise angle 

(the graphic appearance of this information is like that shown for the Coordin command). 

 

The Area button will allow you to insert the first point in which to start calculating the area, 

then the application will continue to ask to select the next point (up to n points) to draw the 

shape for the area measuring; after selecting the last point, just type the command "en" (in 

the command line, from the "end" command) so the function will compute the calculation. 
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The area and the perimeter of the drawn shape will then be displayed in a popup window, 

with a graphic like the one shown for the Coordin command. 

 

The Entity List command, in the Calculations section, provides a list of the elements in the 

project, the list is presented as an editable text file. It is also possible to select just a part of 

the entities to display them in the list (Figure 2.55). 

 

 
Figure 2.55 
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2.5 Topography (tab) 

 

The topographic section consists of four subsections: Topographic points, manage 

coordinates, Fieldbook and Fieldbook schema (Figure 2.56). In the Topographic points it is 

possible to draw a new topographic point, to modify the characteristics of an existing one, 

to select the CAD entities to be used to create new points and to see all the points of the 

project grouped in a table. The Various operations command, if clicked, opens a drop-down 

menu with the commands as in Figure 2.57. You can also create a printable file with a list of 

points. In the Fieldbook section there are the commands to work with polar fieldbooks. You 

can manually create a fieldbook, import it from the PC or import it directly from the total 

station and export coordinate files. 

 

 
Figure 2.56 

 

 
Figure 2.57 
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2.5.1 Topographic points 

 

The Topographic points section is shown in Figure 2.58. The New command is used to insert 

new topographic points, by clicking on this button, you can access a window (Figure 2.59, 

Topographic point properties), where you can insert and customize the graphic properties 

of the created point. 

The properties are completely customizable (note: it is possible to create a point with the 

properties that the application sets by default, e.g. the cross as symbol) and you can select 

the layer to which the point must belong (by clicking on search button next to the Graphic 

layer label). The Select Layer window (Figure 2.60) shows a list of available layers, all of which 

can be activated or deactivated, locked or selected. You can add new layers by clicking on 

the Add Layer button on the bottom left. 

You can also change the name of the point and the font used. You can also change the text 

color selecting a new one in the window in Figure 2.61, by clicking the search button next to 

the Text color label. This window allows you to select a color from one of the available 

clusters (general colors, grayscale, main colors or layer). 

 

 

 
Figure 2.58 
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Figure 2.59 
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Figure 2.60 
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Figure 2.61 

 

The symbol is another feature that can be customized. You can choose a symbol to assign 

to the point (Figure 2.62, drop-down menu for symbol selection), you can define its size, 

color (with a selection window equal to the text color selection) and the rotation angle of 

the symbol. Offset X point-text and Offset Y point-text are the positions of the text calculated 

from the origin of the point. 

As for the Description label, by clicking on the icon next to the label you will access a window 

where you can view a list of possible descriptions (Figure 2.63). You can select existing 

descriptions or add new ones, saving the file with the destination to be specified. If a similar 

file has already been saved, you can select it and display it to use it. 

When all the graphic properties have been set, it is possible to insert the point by identifying 

the position with the mouse or by manually entering the coordinates from the command 

line. 
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Figure 2.62 

 
Figure 2.63 
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Returning to the Topopgraphic points section in Figure 2.58, by clicking on the COGO Points 

button, you can access the list of available COGO commands (Figure 2.64). To use these 

commands, simply follow the instructions appearing at the side of the command line. 

 

 
Figure 2.64 

By clicking Points from CAD entities (in Figure 2.58), you can access two commands: 

Characteristic Points and Equidistant Points or with steps. Using the first, you can select one 

or more CAD entities to create topographic points. In the Characteristic Points window 

(Figure 2.65), you can select a layer (having access to the Select Layer window, as explained 

above). You can enter the name of the starting point and delete the overlapping points. 

Within this function you can further filter the CAD entities to be used by marking the 

available choices. 

The second command, the Equidistant Points or with steps, can be used to create 

topographic points by dividing a CAD entity into equal parts or based on a step, to use the 

command just follow the instructions that appear next to the command line. 
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Figure 2.65 

Returning to the section in Figure 2.58, the next command to explain is the Properties 

command (Figure 2.66), once you have selected one or more topographic points you can 

use this function to discover all their properties and to modify them. 

This window consists of four tabs: General, Graphics, Coordinates, Image. 

In the General tab you find information about the name, description, point code. From this 

screen you can set the information displayed in graphics as point label (point text). To 

change the label of the point just select the items you want to insert from the drop-down 

menu and press the insert button (one item at a time), you can also set the X and Y offset of 

the point text. 

The Graphics tab provides information about the font (font, size, color) and the symbol (icon, 

size, color, rotation) of the point. 

In the Coordinate tab (Figure 2.67), you can read the coordinates Est, North and Quota (as 

average of the coordinates of the various origins of the point), with the relative standard 

deviation. You can change the coordinates manually by selecting the fixed coordinates 

command. In the table called Origin of the coordinates, the origins of the selected point are 

shown, for each origin the name of the fieldbook, the type of origin, the station from which 

it is measured, and the coordinates are reported. 

The buttons below the table are: Create new point from selected origin (available only in 

presence of multiple origin); Properties of the selected origin (opens a screen as in Figure 

2.68, where you can view all the information related to the point, some are editable other 

read-only); Fixed coordinates from selected origin. 
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The Image screen allows you to see if and which images are associated with the selected 

point. 

 

 
Figure 2.66 
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Figure 2.67 

 



 

 

 

 

 

 

Stonex Software Cube-manager v4.3 – User manual           61 

 
Figure 2.68 

 

By clicking on Table points button in Figure 2.58, you can create a table with a list of all the 

points in the project that will be grouped together with their coordinates, names, 

descriptions and codes, as shown in Figure 2.69 (an example of a table with 128 points in 

memory). 
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You can also print the table with the Print button. This button will open a text file editor 

where the table with all the points will be visible, at this stage the table can be modified in 

its fields, contents and graphic appearance. 

 

 
Figure 2.69 

The Mean center command (available in module M) generates a window as in Figure 2.70, 

the function has the purpose of searching for nearby points and averaging the coordinates, 

the search choice generates a window as in Figure 2.71,where it will be possible to decide if 

either to hide or to delete the points from the search result. By default, the program creates 

a new result point with averaged coordinates and points from the search result are put on a 

hidden layer (called LayerHide). 

 

The commands that are grouped in the drop-down list of the Various operations command 

(Figure 2.57): Rename points, Text properties, Text offset are only the repetition for the 

convenience of the user of some functions already present in the Properties window of 

topographic points. 

 

By clicking on Symbol Editor button in Figure 2.57, you can access a screen for the editing 

and addition of new symbols for topographic points, the same operations can also be done 

by clicking the command in Figure 2.28. 
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The last command in the Topographic Points section is the Link command, which generates 

a drop-down menu with two subcommands: Associate CAD block and Associate image to a 

point, which have the purpose to connect respectively a set of CAD elements or an image to 

a topographic point. 

 

 
Figure 2.70 
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Figure 2.71 
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2.5.2 Manage coordinates 

 

The Manage coordinates section is shown in Figure 2.72, each of these commands opens 

pull-down menus with other subcommands. Below the description of all af them. 

 

 
Figure 2.72 

2.5.2.1 Reference system 

 

This command consists of four subcommands, each of which opens a new screen. 

Preset reference system (Figure 2.73) allows you to select a reference system and save it as 

a default system (the program must always have a set reference system and will 

automatically take the user to this window, if no reference system is set). In this screen you 

can select the country and and its Projections, among those available. You can also select 

the Geoid from the drop-down menu that will show all available ones. Note that it is always 

possible to insert a new geoid in the program, thanks to the Upload utility files command 

found in par. 2.1.4.  

A Projection can be changed in its values by clicking on the Create New button, so the new 

edited projection can be saved (it is saved in the previously selected country, in the 

projections’ drop-down menu, in the last position.) To delete it, press Create again, select 

the Projection and click delete). By clicking Show parameters, you can view the values of the 

chosen Projection. 

 

The local reference system command leads to the screen in Figure 2.74. Setting a local 

reference system deletes the predefined reference system. To access the local reference 

screen, there must be at least one topographic point in the active project, considered as the 

origin point. Normally the program will select the first point of the list as the origin point, 

you can always select a new point, among those available on the left at the bottom of the 

list of points. On the right side of the screen you can set the Geoid, the Ellipsoid and some 

of its values, it can also be set the method of calculation that you intend to use in the 

generation of the system. 

 

The Calculation 7 parameters command leads to the screen in Figure 2.75. The list of points 

with geographic and cartesian coordinates will be populated or with existing points in the 

project or can be populated by selecting a text file with the search buttons at the bottom 

right (files can be loaded for both geographical coordinates and Cartesian coordinates). 

Once the list has been populated it will be possible to calculate the false origins and then 
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proceed with the calculation (Helmert or Molodensky). After the calculation you can save 

the system by clicking the Create new Datum/Projection button (which will open a screen 

like the one in Figure 2.76) 

 

Add preset system opens a screen as in Figure 2.76. This window with the relative 

functionalities is the same that is generated if you press the Create new button from the 

screen relative to the Preset reference system command.  

 

 
Figure 2.73 
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Figure 2.74 
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Figure 2.75 
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Figure 2.76 
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2.5.2.2 Rototraslation 

 

In the Rototranslation command (Figure 2.77), there are the functions Translate points and 

3D/2D Rototranslation. The second command is part of the T module - Topography, and it 

will be illustrated in the relevant section. 

By clicking on the Translate points button you access a window in which a list of fieldbooks 

present in the project is displayed (Figure 2.78). The translation can be performed on all 

points (default choice, Select all points checked) or on selected fieldbooks. It is therefore 

possible to set an East translation and/or a North translation and/or a Height translation 

with the relative scaling factors. The exchange of coordinates can also be performed (the 

first choice, selected by default, does not perform any exchange). 

 

 
Figure 2.77 

 
Figure 2.78 
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In the module T the 2D/3D Rototranslation function will be active, the command leads to a 

a window as in Figure 2.79. If in the current project there are topographic points, the section 

relating to the points to be rotated (with headers: East, North, Height in light blue) will report 

all the points present. However, it is always possible to change the points to rototranslate, 

to do this it is necessary to make a choice in the Origin of points to rototranslate (Figure 

2.80), it is necessary to confirm (with the command at the lower-right of the section) to see 

the grid updated. You can choose all the points in the job, select the points part of a 

fieldbook or import the points from a file. 

Once the points to be rotated are selected, the known points can be chosen always keeping 

in mind that the matching between points happens by name (case insensitive). The grid will 

update itself by changing the color of the lines with the matched points, from white to yellow 

and it will move all the matched points to the top.  
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Figure 2.79 

 

 
Figure 2.80 

To choose the known points, you can access a section like the one described for the points 

to be rotated. The section is called Origin of known points, you can choose all the points 

present in the job; the points of a fieldbook; import the points from a file or insert them 

manually; also in this case, it will be necessary to confirm with the command in the section 

to update the grid. 

There are two additional commands for the known points, these are located at the top-right 

of the screen, next to caption ‘Known points’ (Figure 2.81). The first command, with the 

arrows, reverses East and North. The second, the Save known points command, creates a 

text file. 
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Figure 2.81 

In the lower part of the screen, on the left, it will be possible to choose what type of 

rototranslation you want to perform and start the calculation by clicking on the Calculate 

command (Figure 2.82). The 2D and 3D rototranslation can also be barycentric by activating 

the appropriate command. 

 

 
Figure 2.82 

 

As soon as the calculation is performed, the application automatically generates a result 

window as in Figure 2.83, where it will be possible to check the calculation data. 

As with all calculations present in Cube-manager, at the end of the calculation it will be 

possible to view and/or save a report containing the information of the calculation 

performed, it is always possible to carry out the calculation again without leaving the screen. 

In the grid in Figure 2.79, after having performed the calculation, it will be possible to view 

the deltas relating to the East, North and Height. 
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Figure 2.83 
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2.5.2.3 Coordinates conversion 

 

 

The Coordinates Conversion command opens a submenu consisting of three commands: 

Stake-out GPS, Stake-out TS and Coordinates Conversion (as in Figure 2.84).  

By clicking on Stake-out GPS, you can convert the grid coordinates to GPS geographic 

coordinates. After selecting the points (both CAD and topographic) that you want to convert, 

the program will switch to the screen as in Figure 2.85. From here you can define from what 

survey to calculate the stake-out (mandatory), and from which station (mandatory). The 

station may exist, or a new one can be created. Then you can define the options for the new 

topographic points (only in case of CAD points) and for the baselines. 

 

 

 
Figure 2.84 
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Figure 2.85 

 

By clicking Stake-out TS instead, you can select the points to build a fieldbook from Total 

Station. In Figure 2.86 we see the screen for this command, on the left you can select the 

station and orientation, from the list on the right you can select the points you want to 

include as measures of the inserted station. 

In the table below it is possible to view the fieldbook being created, the structure is like that 

which will be described in the next paragraph relating to the fieldbook from total stations. 

Once you have completed the insertions of the fieldbook, you can create a text file or enter 

the processing screens of the fieldbook (Confirm fieldbook command), where you can 
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perform all the classic operations available in the program on the fieldbook from total 

stations (the functions will be described in detail in the next paragraph). 

 

 
Figure 2.86 

 

In the module T, the Coordinate conversion command will be active and, if clicked, it opens 

a screen as in Figure 2.87. This window is divided into two sections, the top dedicated to the 

geographic coordinates, the bottom to the Cartesian coordinates, the coordinates can be 

read from the current job or imported from a file.  

To import the coordinates from a file, it will be necessary to select the file with the relative 

command and then click on Open file, this last procedure is valid for both geographical and 

Cartesian. For the geographic coordinates, it will be necessary to set an input format related 

to the fields, and how the coordinates are written. You can change format and click on Open 
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file to see the updated grid, in case of error just select another format and click Open file 

again. It is possible to save the geographic coordinates on files by clicking on Save 

geographical on file, after having set the output format among those available (they are the 

same as those available also in input, Figure 2.88). 

  

 

 

 
Figure 2.87 

 

 
Figure 2.88  
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The Conversion from geographical command opens a window as in Figure 2.89, where you 

can select the system of origin and destination of the conversion. It is possible to convert 

into Cartesian, geocentric or geographic (which will update the starting grid with the new 

results). 

 

 

 
Figure 2.89 

Below the table for the geographic coordinates you will find useful information and 

commands. In particular, the available information is the number of points contained in the 

table and the origin meridian. The commands are an Undo in case of conversion from one 

reference system to another (remaining in the geographic coordinate grid) and a selection 

command of what type of conversion you want to perform, between predefined systems, in 

local system or convert the origin of longitude. 

 

In the section of the Cartesian coordinates (at the bottom of the screen in Figure 2.87) you 

can read the coordinates from the job in progress, or you can import points from a file. You 

will need to set the format for the fields in import and specify whether the incoming 

coordinates are Cartesian or geocentric. You can also save the coordinates with the Save 

Cartesian command (Figure 2.90). The choices to save the coordinates depend on the active 

job, if you do not have a fieldbook, the program will propose to create a new one, otherwise 
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you will be able to replace or add points to the work in progress (it is always also enabled 

the possibility to compose a new fieldbook). Memorize can also be done by saving the 

coordinates to a file. 

The conversion command from Cartesian opens a window as in. Here it is possible to 

establish a system of origin and destination for the conversion and, as for the geographic 

coordinates, it can be converted into Cartesian, geocentric and geographical. 

Below the table for Cartesian coordinates you can see information on the points contained 

in the table, an Undo command to cancel a possible conversion and a command for selecting 

the conversion you want to perform between predefined systems or in a local system. 

 

 
Figure 2.90 
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2.5.3 Fieldbook 

 

In this section (Figure 2.91) you can import a fielbook as a file, download it from total stations 

or write it manually. The operations that can be performed on the fielbook are the 

memorization, calculation and export of the points calculated in the CAD. The program 

controls the measurements of horizontal, vertical, direct and inverse readings and performs 

the averages. The program also checks for points with the same name measured several 

times within the same station and check that the measurements are averaged. Note that the 

information displayed, when importing a Total station file does not show the raw files, what 

is displayed is the result of a reading and interpretation of the data by the application. 

 

 
Figure 2.91 

 

2.5.3.1 Edit fieldbook 

 

By clicking on the Edit booklet button, you access a submenu as shown in Figure 2.92. 

 

 
Figure 2.92 

 

The available functions are: New fieldbook (manual), Open existing fieldbook, Create 

fieldbook from file (with extension from Stonex Total stations), Fieldbook from job. 

 

By clicking on New fieldbook (manual), you can manually write a fieldbook; in the first screen 

that follows (Figure 2.93) you can give a name to the fiedlbook (mandatory choice, otherwise 

the program will not allow you to proceed), and then enter a series of other information 
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related to the latter. All fields are left blank, only the date is set automatically by the system, 

but can be changed. 

 
Figure 2.93 

 

The next screen clicking OK automatically leads to the first measurement (Figure 2.94), by 

default the name of the first station is St1 and is defined as temporary ("Temporary" means 

that the coordinates have not been calculated, "Calculated" means that the coordinates have 

been calculated in the field and "Known" means it has known coordinates). The height of the 

instrument is set to 1.00 m, all other details are left blank and can be entered by the user. 

Even the details provided as default settings can be changed. As for the Information label, if 

you click on the icon next to it, you can access a function like the one described above (Figure 

2.63). 

 

In the section related to the details of the point, the default assigned name is Pn1 and its 

coordinates are considered temporary (with the same logic used for the stations). Other 

values set by default are the height of the pole, the vertical reading, the temperature and 

the pressure, these values can always be changed. 

For horizontal readings, vertical readings and distances, the application dynamically 

calculates the averages and residuals, returning a correct value also based on the settings of 
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the survey elements (right on the screen: prism constant, temperature, pressure, transverse 

eccentricity, horizontal eccentricity). 

 

By clicking on the icon with the wrench on the right, you can access the list of parameters 

related to the fieldbook (Figure 2.111). Parameters for setting the decimals you want to 

display on the screen and the representation of the angles. Furthermore, it is possible to set 

a series of tolerances and a series (on the right) of other values, which the system will 

consider when calculating the measurements. 

 

At the bottom of the screen (Figure 2.94), it is possible to read the information resulting 

from the calculations (considering the set parameters), relative to the horizontal distance 

and the height difference, including the difference in height between the height of the 

instrument and the height of the prism. 

 

 
Figure 2.94 

 

After entering the information of the new station and the new point, clicking the Add button, 

the application will open a new screen (Figure 2.95), where you can view a table with all the 

stations created and their points. The lines in the table are yellow or white, alternating each 

time the station changes so it will be easy to identify at a glance the passage from one 

station to another. 
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In the table screen you can enter a new station and its first measurement or a new 

observation. In the first case the station name will be sequential to the last one inserted and 

the point name will be left blank, in the second case the name of the station remains the 

same and the name of the point will be sequential to the last one created. 

With the right-click on the table, you access a menu of options that, depending on the 

selection made (number of cells and position) offers a series of functions (Figure 2.80, some 

options seem to be disabled but they are all available, for facilitate the use of the menu some 

functions become dynamically active while others are deactivated). 

These functions are simple to use, you can insert a new measure between the already 

inserted observations (Enter observation), you can add a new observation at the end of the 

table (Add observation), you can change the entered numerical values as well as the names 

of the points and the selected lines can be deleted. 

These operations can be canceled by clicking the icon at the bottom left of the screen (blue 

undo icon). 

 

When all the observations have been entered, it is possible to press the End of manual entry 

button and the screen will automatically change its appearance (Figure 2.97); you can see 

the table and, in at the bottom-left you can select the desired station, to place the visible 

part of the table on it. 
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Figure 2.95 

 
Figure 2.96 
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Figure 2.97 

 

 

In Figure 2.97 the command on the top-left, Fieldbook menu, if clicked will offer a series of 

operations possible on the fieldbooks (Figure 2.98). It is mandatory to use one operation to 

proceed. 

 

In the Fieldbook menu, the Calculations command consists of four subcommands: Traverse 

calculation, Detail calculation, Various calculations, 2D network calculation. The only 

calculation available with the basic functions of the Cube-manager is the detail calculation, 

the others are included in Module T – Topography, and they will be illustrated in the relevant 

section. 

 

Detail calculation 

To carry out the detail calculation, just click on the relative command that will lead to the 

screen in Figure 2.99, on the left is the list of stations present in the job, you can select and 

calculate one or more stations by clicking on them, or you can calculate all the stations by 

clicking on the Transfer all button. 
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The list named Stations to be calculated will show the stations that you chose to calculate, 

when you click on Proceed, if the system does not find known points, it will generate a screen 

(Figure 2.100), where you can select the station and the first orientation (coordinates can be 

assigned/changed if necessary). To start the calculation, it is possible to click on Confirm 

calculation (Figure 2.101). Uncalculated stations will be displayed in the list on the right, 

named Stations not calculated; help messages will appear below the list (in this example, 'All 

stations calculate ', 'All backsights in the expected tolerance’). View report button will show 

an html file with the details of the calculation, the Repeat calculation button will perform the 

calculation again. On the right there are the differences of East, North, Height between the 

maximum and minimum values found in the work, this information can help to find errors. 

The X-gray icon will delete from the list of stations to be calculated the one selected, the 

trash icon will erase all stations in the list. The icon with the wrench leads to a window like 

the one shown in Figure 2.111. 

 

 

 

 

 
Figure 2.98 
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Figure 2.99 

 
Figure 2.100 
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Figure 2.101 

 

 

Traverse calculation 

The traverse calculation is an active function in the module T. To perform the calculation, it 

will be enough to select this function from the Calculations command (Figure 2.98, above). 

The screen for this calculation is shown in Figure 2.102. The operation is like that described 

for the detail calculation, in this case however the selection order and the choice of the 

stations to be calculated must follow the logic of the traverse, surveyed in the field. The 

program will automatically recognize what type of traverse you are trying to calculate, the 

gray rectangle on the right will change appearance indicating a caption between: Open 

traverse, Open constrained traverse, Constrained traverse, Closed traverse. 

 

The commands View report, Confirm calculation and Repeat calculation will not be visible as 

soon as the screen is opened but will become visible once the vertices of the traverse to be 

calculated have been selected and once the Proceed command is clicked. As with any 

calculation performed by the program, a detailed report with the results will also be 

generated in this case. 

For the calculation of a closed or a constrained traverse, a window will be displayed as in 

Figure 2.103, where angular and linear closure tolerances can be set, which will be used in 

the calculation. Furthermore, a window like the one in Figure 2.104 will be presented, where 

the orientations can be read. With the command on the bottom-left called Distances/Height 
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differences, the screen in Figure 2.105 will be displayed, for a detailed reading of the 

distances and differences in height between the vertices. 

 

 

 

 
Figure 2.102 
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Figure 2.103 
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Figure 2.104 
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Figure 2.105 

 

Various calculations 

By clicking on the Various calculations button, you can obtain calculations of free stations, 

forward intersections and reverse intersections. The window looks link those encountered 

for the other topographic calculations, related to total stations (Figure 2.106). The list on the 

left shows all the stations, the known points and the measures present in the job, the 

selection with the click, causes the movement of an element from the list on the left to the 

one on the right, and the program is able to provide information on the possibility or not of 

calculating this point. If the program, based on the selection made, finds the possibility to 

calculate the intersections even with least squares, it will propose to perform also this second 

calculation. A window like the one in Figure 2.107 will open automatically. The functions and 

the possible settings in this screen are the same as those found in the case of the 2D network 

calculation. 

 

 

 

 



 

 

 

 

 

 

Stonex Software Cube-manager v4.3 – User manual           94 

2D network calculation 

If the topographic survey was carried out to have redundant measures and known points, 

after making a provisional calculation of the coordinates, it is possible to continue with the 

calculation of the 2D network compensation. The window is like the one in Figure 2.107, on 

the left the known points are summarized, in the list on the right the points to be calculated 

are summarized. For this calculation, you can set the angular and linear precisions (as a 

constant and as a ppm value), the precisions can be set globally or by clicking on the Assign 

accurary to every measument button, for each measurement, a table will open (Figure 2.108), 

where you can manage them individually. It is possible to enable a UTM correction, in case 

of surveys that requires deformation correction. If the calculation you are about to perform 

is a simulation, you can also assign an SQM value of weight units. 

The number of equations and unknowns provided for the calculation are also available for 

consultation in the window. As with any other topographical calculation, also in this case, a 

report will be displayed with the results reported in detail and it will be possible to confirm 

the calculation or carry it out again. 

 

 
Figure 2.106 
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Figure 2.107 
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Figure 2.108 

 

Returning to the commands in Figure 2.98, View all measurements, View averaged 

measurements and Calculate averages are other available functions, the first two are display 

options, the last, work on the fieldbook, taking all the measures into consideration and 

calculating the averages. 

This last function (Calculate averages) opens a screen (Figure 2.110) in which it is possible to 

set tolerances, text colors, layers, symbols and relative colors (for known points, detail points 

and stations), decimals, representation of the angles and corrections (such as atmospheric 

refraction), clicking Proceed the program will proceed to the average calculation. 

 

The Load known points command opens a menu with three options: Read from file, Read 

from current job, Cancel known points. The first command opens a screen where you can 

select a text file containing the coordinates and indicate a separator character (Figure 2.109). 

 

Work parameters will open a window as in Figure 2.110. 

 



 

 

 

 

 

 

Stonex Software Cube-manager v4.3 – User manual           97 

 
Figure 2.109 
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Figure 2.110 
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Figure 2.111 

 

Among the commands shown in Figure 2.98, the Enable manual entry button will lead to the 

manual writing section of the fieldbook (described above). 

 

The View report command will open a screen with a html file containing all the information 

on the current fieldbook. If the program recognizes that there are several reports present in 

the job, a window will open in which all the reports will be displayed so that you can select 

the one you want, in this screen you can also delete (one or more) reports. 

 

Insert fieldbook in the job button will insert the fieldbook in the graphics; before proceeding, 

the application will check the presence of average measurements and if the calculations have 

been performed, then it will be possible to see again a summary of the measurements (any 

unaveraged measurements will be visualized on red lines, so that corrections can be made).  

 

With the Memorize fieldbook you can save the fieldbook; after displaying the screen with 

general information (e.g. fieldbook name, date, location, etc.), once you have chosen the 

destination for saving, the application will produce a file with the .cubefbk extension. 

The Print fieldbook command allows access to the general information screen on the 

fieldbook (as in Figure 2.93, where you can change all the fields if necessary), when you click 

on Proceed the application creates a html file, ready to print. 
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The last commands are related to the export, the fieldbooks can be exported in GSI format 

(18 and 6 bit), in IDX and in text files (as well as in the native format of the program .cubefbk). 

 

2.5.3.2 Import and export fieldbooks 

 

The Import fielbook button (Figure 2.112) allows to import fieldbooks from total stations; 

you can import using a USB connection by connecting directly to the total station (after 

clicking on the chosen device, click on the Connect USB button) or selecting a file that may 

be stored in the PC.  Figure 2.112 shows all supported devices (in Figure 2.113 all the 

supported extensions). 

The Export coordinates button allows you to export to the total station formats and to GSI 

(16 bit and 8 bit). 

 

 

Figure 2.112 

 

 
Figure 2.113 
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2.5.3.3 Leveling 

 

The Leveling command consists of three subcommands: Download; Trigonometric leveling; 

Geometric leveling. The first opens a screen as in Figure 2.114. 

After selecting (at the top) a data destination file and setting the data for the input port, you 

can download data from a digital level. 

 

 
Figure 2.114 

 

2.5.3.4 Trigonometric leveling 

 

To perform trigonometric leveling, a fieldbook must be inserted in the work with the 

extension specified by the program (.cubefbk). In the fieldbook there must be some known 

heights from which to start the calculation (Figure 2.115). It is also possible to manually enter 

points. 
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Figure 2.115 

 

2.5.3.1 Geometric leveling 

 

To perform geometric leveling you will have to insert a text file with difference in heights. It 

is also possible to manually enter points. Once the text file has been imported, the screen 

for the function will be like the one in Figure 2.115. 
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2.5.4 Fieldbook schema 

 

The button for activating or deactivating the fieldbook schema can be found in the 

Topography tab (Figure 2.116). The checkbox named Show, will activate or deactivate the 

drawing. The Options button wil open a window as in Figure 2.117, in this screen you can 

determine whether to display the links, both for the GPS fieldbooks and for the polar 

fieldbooks, the color to give to the links and if you want the connections to be visible in the 

printout. In Figure 2.118, an example of work with a visible fieldbook scheme. 

 

 
Figure 2.116 

 

 
Figure 2.117 
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Figure 2.118 
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3 Constraint (Module M) 
 

In the Lines/Constraints tab you can find all the drawing and editing functions for the 

contraints. 

This section is divided into 4 sub-categories: Pregeo, EDM Extract, DTM, Modify. 

 

The first 3 sub-categories contain commands for drawing contours or constraints; Pregeo is 

divided into 9 commands, each of which generates a black, red or green outline, with a 

continuous line, dotted or dashed, following the italian Pregeo style. 

 

 
Figure 3.1 

3.1 EDM extract and DTM 

 

EDM extract section will allow to draw a contour by selecting what type of contour it is, the 

types provided follow the Italian Pregeo style. 

The DTM sub-category will allow to design a constraint boundary or generic exclusion 

without belonging to a Pregeo category. The drawing of the contours or constraints, for all 

the commands described so far, takes place in the same way, once the command has been 

selected, it will be necessary to give a name to the contour (to be inserted in the command 

line at the bottom, in the main Cube-manager screen, Figure 3.2) and confirm with the enter 

key. Then, following the instructions to the left of the command line, it will be necessary to 

proceed by selecting the topographic points that make up the outline (the command en, to 

the left of the command line - Figure 3.3 - ends the drawing function; the command tab 

allows the selection of points from the summary table of the topographic points). 

 

 
Figure 3.2 
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Figure 3.3 

3.2 Modify constraints 

 

The commands contained in the Modify sub-category. The first command, From point, is a 

utility command for drawing the contours, by clicking a point inside a closed CAD entity 

formed by lines and/or polylines, it is possible to transform it into a constraint (or exclusion). 
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Figure 3.4 

The window for creating a contour from an internal point is shown in Figure 3.4. To save the 

contour, it will be necessary to give it a name, it is also possible to establish what type of 

contour it is, by default a generic constraint will always be created. At the bottom of the 

graphical features table, mainly designed for Pregeo users, it is possible to change the types 

of lines that make up the outline, subdividing them by vertex or point. 

At the bottom, you can see on the left the Contour List, selecting a contour already present 

in the job, this will be included in the table on the right (Internal area list) and this will 

become an exclusion area in the current contour to be created. 
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Returning to the commands in Figure 3.1, the Property command opens the same window 

as in Figure 3.4, with the characteristics of the selected contours, it is possible to change 

some features, such as the layer to which it belongs. 

 

The Delete command allows the cancellation of contours. The Insert point, Delete point, New 

points and Split in two commands can be used if you have created a contour with 

topographic points, these commands will quickly allow you to modify the selected element. 

The Modify stroke command allows the selection of the outline and the subsequent 

modification of the style (following the type of lines proposed in the italian Pregeo). 
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4 3D Models (Module M) 
 

The 3D Models Tab is divided into 4 sub-categories: DTM; Contours; Volumes; Profiles. 

 

 
Figure 4.1 

4.1 DTM 

 

DTM contains the commands already encountered, Draw constraint and Draw exclusion, 

illustrated in the paragraph of Contraints. Elaborate DTM is the command that allows you to 

draw a digital model starting from a constraint. 

The screen for drawing a digital model is the one shown in Figure 4.2. On the left you can 

select the points and polylines layers that you want to use for the creation, by default all the 

points and all the layers of the current job are selected. On the top right you will have to 

select a constraint from which to start the model creation, you can choose between selecting 

with the mouse directly from the graphic, selecting it from a list of constraints (included in 

the current job) and automatically creating a constraint given a fixed distance between 

points (to be entered, even if the program suggests a value based on the current job). At the 

bottom you will have to enter some features of the DTM, the name of the constraint (if not 

already entered with the selection), the color and the maximum and minimum height of the 

model. The name is mandatory, the other features are set by default or not strictly necessary 

for creation. Clicking the button Create DTM at the bottom will close the window and 

generate the model in graphic. 

The Invert command (Figure 4.1) allows the selection and inversion of two 3D faces. 
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Figure 4.2 

4.2 Contour lines 

 

This function is composed of 5 commands, the first called Generate, opens a window as in 

Figure 4.3. For the creation it is possible to set the reference layer of the digital model on 

which you want to generate the curves, by default all the DTMs. On the left it is possible to 

set the distance between the major and normal curves, the colors and the layers to which 

they belong, in Figure 4.3 you can see the values that the program assigns by default if a 

setting is not made by the user. It is possible to draw the heights for the major curves (in 

this case it is possible to set the font and the size), at the bottom you can see other values 

as the elasticity factor of the curves, these values can be modified, in any case the program 

always proposes values consistent with current job. 
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Figure 4.3 

The second command in the Contour lines section opens a screen as in Figure 4.4. By clicking 

on the command, it will be necessary to select the curve or curves whose rounding is to be 

modified. Moving the blue indicator towards the + or - it is possible to evaluate the result 

of the modification in graphic. 
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Figure 4.4 

The last 3 commands in the Contour lines section are transformation commands from 

polylines to contour lines and vice versa or from polylines to b-spline curves. 
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4.3 Volumes 

 

The Calculation of volumes command opens a window as in Figure 4.5. It is possible to set, 

on the right in the Layer section of the DTMs, which layer to consider for the calculation, by 

default all DTMs present in the current job are always selected. 

Volumes can be calculated by setting a horizontal plane or 3D plane passing through 3 

points. By default for the horizontal plane the lowest height of the DTMs will be shown, for 

the 3D plane the first 3 points of the DTM will be shown. 

 

 

 
Figure 4.5 

 

To proceed click on Calculate volume, the window in Figure 4.6 will be displayed. On the left 

side you can see the cut and fill volume expressed in cubic meters, the horizontal and 3D 

area, expressed in square meters. 

It is possible to display (and possibly save in memory) the calculation report, the program 

proposes 3 possible reports, the first essential with the data that are displayed in the upper 

part of the window; the second detailed, in which for each 3D face the coordinates of the 

vertices are reported, the delta of the heights, the horizontal area, the 3D area, the volumes; 

the third with the 3D area, the horizontal area and the volume of each 3D face. 
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Figure 4.6 

 

On the right side of the screen in Figure 4.6, it is possible to set the visibility and the graphic 

characteristics of the numbering of the 3D faces and of the intersection lines with the volume 

plane. 
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4.4 Profiles 

 

The Create profile command has a drop-down menu as shown in Figure 4 7, from which you 

can select the desired functionality from those proposed. 

 

 
Figure 4.7 

The selection of one of the first two functions - Profile on single line/polyline and Profile on 

concatenated lines/polylines – opens a window as in Figure 4.8, the difference between the 

two commands is simply on the type of entity (single or concatenated), on which you want 

to build the profile. In the second case the selection of a line or polyline causes all the 

lines/polylines that will have vertices in common to be selected and linked. 

In the window in Figure 4.8, we find the first setting for the creation of a profile, as a first 

step it is necessary to select whether to build the profile on all the elements intersected by 

the line or only on the vertices. Another choice to make is if you want to insert topographic 

points, if yes, you will have to indicate if they must be inserted in all points intersected by 

the line or only on the vertices. The graphic elements related to the symbols, in the lower 

part of the window, are activated only if you want to insert topographic points. 

Clicking the Create profile button takes you to the next profile management screen, to 

complete the creation settings (Figure 4.9). 

This window is divided into two areas, the upper part shows the summary of the 

points/vertices that make up the profile, in the lower part you can see the graphic 

representation of the profile, moving the mouse on the profile, the selection of the point on 

the upper table, will change according to the position of the mouse. To save the profile click 

on the Save profile button, so a Cube-manager file with the .cubeprf extension will be stored. 

 

 

 



 

 

 

 

 

 

Stonex Software Cube-manager v4.3 – User manual           116 

 
Figure 4.8 

 

 
Figure 4.9 
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Between the two areas just described, there are some commands for the management of 

the profile, the first one called Advanced Information, if clicked it modifies the aspect of the 

summary table as in Figure 4.10. It thus passes from a visualization with essential information 

on the points of the profile to a detailed view. The Crossing column offers a drop-down 

menu, with default information that can be selected. All the other cells of the table, both in 

the essential and in the detailed one, if clicked generate a window as in Figure 4.11. 

 

 

 

 
Figure 4.10 

 

 

 

 
Figure 4.11 
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The window allows the modification of information on the points, to save the changes click 

the Save button. 

 

 
Figure 4.12 

 

 
Figure 4.13 
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The Design profile command opens a window as in Figure 4.12. At the top left, the new 

vertices of the design profile can be entered and saved, those will be displayed in red at the 

bottom, in the graphics and shown in the table above. Click Back to return to the general 

profile management (Figure 4.9). 

Returning to the commands in Figure 4.9, the Invert profile command performs an inverse 

ordering of the vertices of the profile, which will also be affected in the graphic display. 

The Export… command allows the creation of a CSV (Comma Separated Values) file with a 

summary of the points that make up the profile. 

By clicking the Next button, you can access the screen in Figure 4.13, where it is possible to 

continue to set the general parameters and profile descriptions. In the left part of the window 

we find the general parameters that are related to the graphic and profile print elements, 

they are always present with default values. In the right part you can set the descriptions 

that you want to report in the profile, the table above shows the ones that will be reported. 

These can be enriched by clicking on the list at the bottom to add new descriptions that will 

appear automatically in the table above. Selecting a description from the table, this can be 

repositioned with the help of the blue arrows or it can be removed from the table by clicking 

on the X, by clicking on the trash you can delete all the descriptions in the table. 

 

 
Figure 4.14 

 

Clicking Next you access the window in Figure 4.14. This last screen will be useful to set the 

last settings before creating the profile in graphic. At the top of the window is the section 

relating to the profile header. The headings entered with the relative position will appear in 

the table on the right. In the lower part, we find the Draw profile section in which you can 

indicate the chainage of the profile you want to draw, the scales of lengths and heights. The 
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Draw profile command populates the table in the section of the profile size, which shows 

the expected height jumps in the required profile, after entering a name for the profile you 

can click on the Drawing button to proceed with graphic creation. In Figure 4.15 a profile is 

shown as it appears in the graphic after the creation, keep in mind that the starting project 

will be closed before drawing the profile, if you do not come from a .cubeprf file the program 

will ask if you want to save the project before closing it. 

 

Going back to the commands in Figure 4.7, the Open existing profile command opens the 

profiles saved in Cube-manager with a .cubeprf extension. 

The Entering a manual profile command enables a manual entry of the points that will create 

the profile (the window is like the one in Figure 4.11). The Save command adds the current 

point. To continue adding points click on the Add point command (Figure 4.16) which will 

appear below the points summary table. Once all the points have been entered manually it 

will be possible to work on the profile as indicated in the first part of this paragraph. 

 

 
Figure 4.15 

 

 
Figure 4.16 

  



 

 

 

 

 

 

Stonex Software Cube-manager v4.3 – User manual           121 

5 Raster (Module T) 
 

 
Figure 5.1 

 

The Raster Tab provides the tools to work with raster images (Figure 5.1). This section is 

divided into two subsections: In/Out and Modify. 

In the first part there are the commands Import raster and Delete raster which are available 

for all modules. The formats supported both in import and in export are: BMP; GIF; EXIF; JPG; 

PNG; TIF; TIFF. 

The first command in the Modify section is Properties, the window is the one shown in Figure 

5.2. 

 

 
Figure 5.2 
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With this command you can read and modify the graphic properties of a selected raster 

image. 

The Move, Rotate and Crop commands, after selecting an image and a starting point, will 

allow you to see a preview of the change as in Figure 5.3. 

The commands Resize and Meters-Pixels x,y, will be executed from the command line, the 

appearance will be similar to the one in Figure 5.4 (Resize command). 

 

 
Figure 5.3 

 

 
Figure 5.4 

 

 

The Merge command allows the merging of two images, the graphic result will be assigned 

to the selected image but the original will not be modified, a new image will be created by 

saving the current project. 
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The last two commands, Order and Flip, both have a drop-down menu composed of two 

elements: Bring to front – Send to back for the First Command; Vertically - Horizontally for 

the second command. Selecting the image will make the selected function effective. 
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6 Post-processing (Module P)  
 

To perform a postprocessing click on the Postprocessing tab (Figure 6.1), and then select 

the type of operation to be performed from those available: Stop&Go, Kinematic, Single 

Static single (with sigle base), Multiple Static and Network. 

 

 

 
Figure 6.1 

6.1 Stop & Go calculation 

 

Before describing the functions of this section, we provide an example of a circumstance for 

which it would be useful to generate a Stop & Go calculation. For example, having a job 

performed in RTK mode, there may be points that are not affected by these corrections, thus 

remaining in single or float or GPS mode. The calculation can attribute to these points a 

correction such as to bring them back to the fixed mode. It is necessary for a good success 

of the differential calculation that these points have been detected for a time that can 

generally be positioned between 15 s and 30 s, the minimum acquisition time depends on 

the instrument used and the reference base. An acquisition time between 15 s and 30 s 

means having between 15 and 30 common epochs, between the base and the Rover. If the 

acquisition frequency is lower than 1 Hz, the acquisition time must be proportionately 

greater. For example, acquiring every 5 s, to have 30 common epochs, it is necessary to stand 

for 150 s. 

 

Let's look at the working phases of a Stop & Go calculation: as a first operation, we remind 

you that it is necessary to set a correct reference system in the program, in order to obtain 

valid results. To perform a Stop & Go calculation, you must first upload a GPS job in the 

active project, using one of the import functions provided by the application. The first 

question that is asked is if you want to consider also the RTK fixed points in the calculation 

(this operation can be used to compare the fixed positions, with the postprocessed 

positions). The next screen (Figure 6.2) shows a table with a summary of the fieldbook 

involved in the job, the points list, the instrumental heights, the starting time, the occupation 

time and the status of the points surveyed. The possible actions in this phase by the user are 

the selection or deselection of the points to be involved in the calculation and the 

modification of the instrumental heights. 
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At the bottom of the screen, it will be necessary to confirm whether the value regarding the 

pole height, reported in the RINEX file, has been recorded at the base of the antenna or at 

the phase center. This choice is necessary and must be made with care so as not to invalidate 

the subsequent calculations. 

For the Stop & Go calculation, the user can control the workflow manually, from the second 

screen onwards it is possible to advance or go back with the buttons with the arrows at the 

bottom (Figure 6.2). 

 

 

 
Figure 6.2 

 

The next step, after displaying the summary table of the points to be calculated, is shown in 

the screen in Figure 6.3.  

In this phase you will have to select a raw data file produced in the field and related to the 

GPS survey present in the project (the program supports also the multi-selection of raw data 

files). The raw data formats supported (both for the Rover and for the Base) are, as binary 

format: 

* .dat (for all receivers in the Stonex range, except for S4H2) and * .log (for the S4H2 receiver); 

regarding the RINEX format: V2 and V3 uncompressed or compressed (Hatanaka). 

The selection of the Base file (produced by another GPS or by a permanent station) generates 

the opening of a screen like the one in Figure 6.4, where it will be possible to read the 

coordinates (it is possible to display the measurement of the coordinates at the phase center 

or on the ground). The user can decide to enter the coordinates of the base manually or ask 
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the application to recalculate them; you can also enter the antenna height and set the 

coordinate format. 

Selecting the base RINEX file also causes the auto-selection of the navigation files in the 

same folder (it is also possible to manually import the files). The program supports specific 

files for each constellation, or mixed. 

The raw files and the navigation files just imported can be selected or deselected from the 

relative tables; furthermore, by clicking on the button with the X icon on the lower left side, 

all the imported files can be deleted. 

At the bottom you can see a window showing the occupations of the imported files, which 

is updated with the addition of a new file, the numbers at the top indicate the time interval 

of the imported files (and the GPS work present in the project). 

 

 
Figure 6.3 
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Figure 6.4 

Pressing Next, you will see the screen in Figure 6.5, where it is possible to set the parameters 

useful for the calculation. In this screen it is possible to select the constellations to be 

considered for the calculation (N.B. the GPS constellation cannot be deselected). 

An observation method can also be assigned, the check on the Code cannot be deselected. 

In the Other options group, it is possible to define the elevation values (recommended 15 

degrees), the minimum coefficient of resolution of phase ambiguity (the recommended 

value is 2) and minimum signal-to-noise ratio (the recommended value is 35), this last value 

can be assigned to the Rover and / or Base. 

In the current version, broadcast Ephemerides are used, and precise Ephemerides are not 

activated. 

In the lists of satellites used, the satellites used for the calculation can be selected or 

deselected, the undo button at the top right restores the starting situation with all the 

selected satellites. The Restore default values button restores the values of all the other 

parameters. 

Once the desired parameters have been set, it is possible to proceed with the calculation by 

clicking on the button Perform post-processing calculation, the calculation can be 

interrupted by clicking on the Stop button (when the calculation is running, the window in 

Figure 6.6 will appear on the main screen). 
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Figure 6.5 

 
Figure 6.6 

 

The end of the calculations generates the Calculation Results page (Figure 6.7), where a table 

is shown with the list of calculated points. The columns of the table provide useful 

information on the points, it will be possible to view the coordinates measured for each 

point, the correct coordinates and the standard deviations. The state of the points is 

highlighted by the alternation of the colors between the lines (fixed, SBAS and DGPS in white; 

float in cyan; PPP in yellow; single in orange). 

At the bottom-left of the screen you can see a statistical summary of the calculated points, 

while at the bottom-right you can filter the points that will be reported in the job (eg based 
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on the state or based on the values of the standard deviation, in this case the points above 

the set value will not pass the filter). 

Before completing the work, you can produce a report of the calculation results. With the 

End Job button you will generate a window (Figure 6.8) in which you can specify whether for 

the calculated points you want to generate a new fieldbook (the calculated points will have 

a prefix in the name: 'postp_', preset but editable), or if you want to replace the points 

previously imported in the project and visible in the graphic. 

 

 
Figure 6.7 
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Figure 6.8 

 

Before finishing and saving the work it is also possible to intervene with advanced settings 

on the points, in order to correct and improve the calculation. These correction functions 

can be accessed with the buttons with the arrows at the bottom (Figure 6.7). 

Clicking the Back button, you can access the Point Analysis screen (Figure 6.9), this function 

allows you to work and perform the calculation on single points. Points can be selected from 

the list on the left; on the right you can see the epochs and satellites used (the change of 

epoch is highlighted by the alternation of colors yellow-white).  

At the bottom-left, satellite readings can be enabled or disabled relative to the selected 

point. Save point configuration and recalculate button will lead on the page of calculation 

parameters for possible corrections on the settings and will execute the calculation only on 

the selected point. The application will then show the new calculation results, related to the 

modified point.  

If you go back to the Point Analysis screen and have already performed calculations on single 

points, the list on the left will show an identification symbol. The icons on the left, in the X-

icon and bin-icon will respectively cancel a single configuration, or to delete them all. 
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Figure 6.9 
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6.2 Static calculation with single base  

 

The Static is a calculation that assumes to obtain a much greater precision than the Stop & 

Go, in fact the points surveyed in static mode in the field have been acquired for a time of 

some minutes or hours, occupation much higher than the one needed for the Stop & Go. 

The first working window, if you choose to perform a Static calculation, will give you the 

possibility to select one or more raw data files that correspond to static surveys performed 

in the field by the operator (Figure 6.10). 

 

 
Figure 6.10 

 

The processing screens, after clicking the Next button, are like those encountered in the case 

of the Stop & Go calculation. The following screen, the selection of the raw files, will allow 

the selection of the base file (the top section relating to the selection of raw files, is active 

only in Stop & Go mode). Please refer to the previous paragraph for the description of the 

processing steps, for the user they will look the same but of course the calculations will be 

carried out by the application in a different way. At the top, the window title, after the word 

Postprocessing there will always be the title of the selected calculation. The recommended 

parameter configuration, in the case of the Static calculation, is the following: elevation 

value, 10 degrees; minimum coefficient of resolution of phase ambiguity, 3; minimum signal-

to-noise ratio, 30. 
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The final processing phase will end with a window where it will be possible to name and save 

a fieldbook with the results of the calculation performed (Figure 6.11). 

 

 
Figure 6.11 

 

To save the project as a *.cubemgr file makes possible to perform the static calculation on 

other observation files, later in time. This option has been made available to have the 

possibility to create a project extended over time, adding the new fieldbook that will be 

calculated, to the already existing one.  

To add new calculated points to an existing fieldbook, simply reopen the saved project and 

click on the single Static command to perform  the calculation, Cube-manager will 

automatically ask if you want to continue working on the current project without creating a 

new one. 

 

6.2.1 Satellite analysis 

 

When performing a post-processing, it is always possible to analyze the satellites of the base 

or the bases and rovers. 

This function can be activated by clicking on the occupancy bars, visible before the screen 

to set the calculation parameters (Figure 6.12). 

Clicking on one of the occupation bars will cause the calculation parameters screen to open, 

where the Satellite analysis command will be active (Figure 6.13). 

To carry out the analysis of the satellites, simply click on the command Satellite analysis, the 

screen is shown in Figure 6.14. It will thus be possible to observe the graphic representation 

of code, frequencies, elevation, noise signal, divided by satellite. 
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Figure 6.12 

 
Figure 6.13 

 

 
Figure 6.14 
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6.3 Kinematic Calculation 

 

The kinematic calculation is intended to show the path of the mobile rover. With the mobile 

rover, a position is obtained for each epoch (path) Figure 6.18. 

Let's look at the processing phases of a kinematic calculation: as a first step, we remind you 

that it is necessary to set a correct reference system in the program, in order to obtain valid 

results. If you want to carry out a kinematic calculation combined with the Stop & Go 

calculation, you will need to import a GPS survey into the project, however the program will 

always ask for confirmation of the action to be performed (whether just kinematic calculation 

or kinematic calculation + Stop & Go). By pressing Yes in Figure 6.15, the Stop & Go points 

of the survey will be included in the calculation. 

In this way, the procedure and the steps are identical to those of the Stop & Go calculation 

described in paragraph 3.1. 

 

 

 
Figure 6.15 

 

If there are no Stop & Go points to calculate, the first screen that will be displayed by 

performing a kinematic calculation will be the one shown in Figure 6.16, also in this case it 

is possible to follow the steps and recommendations already described in paragraphs 3.1, 

for the Stop & Go calculation (Figure 6.16, you can see the screen for the kinematic 

calculation is very similar to the Stop & Go window). The values of the calculation parameters 

(such as the SNR-Signal-to-noise-ratio) that we suggest using are always set as default 

values, proposed by the program. 
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Figure 6.16 

 

At the end of the processing, the program will present a window as in Figure 6.17. 

You can then decide whether to import the calculated path (as a polyline) into the work, the 

points that make up the path, or both. For the points the program proposes a default starting 

name (Kpt1), the others will be sequential, the starting name is always editable. Finally, you 

can choose to include Stop & Go points in the calculated path. In Figure 6.18, an example of 

a work resulting from a kinematic calculation with path and Stop & Go points. 

 

 
Figure 6.17 
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Figure 6.18 

 

6.4 Static calculation with multiple bases 

 

By clicking on the Static multiple command, it is possible to create a network project, this 

calculation is often used to check the position of some points over time. In Cube-manager 

it is possible to create an automatic, a manual project or open an existing one (Figure 6.19). 

The automatic project executes the network project automatically by creating all baselines 

between known points and points to be calculated and between points (based on 

occupancy, to create averaged points). In this case, select the files to be processed (Load 

observation file) and then click on the known points files to define them as a reference (from 

the Observation file table the selected files will be transferred to the Known base file table), 

then click on Calculate baseline (Figure 6.20). The manual project requires to insert one file 

at a time, the known points are inserted by clicking on Add new base and those to be 

calculated on Add new baseline. In the table, the known points are on the left and those to 

be calculated on the right; baselines can be inserted between unknown points, thus 
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processing an unknown point with respect to another unknown point but only if these have 

been inserted as points to be calculated above in the table. The selection of the navigation 

files is always automatic, if the program fails to find the navigation files, it proposes a manual 

selection.  

In Figure 6.21, you can see the screen that groups the bases and baselines related to the 

current project, whether it comes from an automatic creation or a manual creation. 

In this phase it is possible to add base and/or baseline, and memorize the project. In the 

table the known points are on the left and those to be calculated on the right, baseline can 

be created between unknown points (thus processing an unknown point with respect to 

another unknown point) but the point (to use as base) must have been previously entered 

(as baseline from a known point).  

The selection of the navigation files is always automatic, if the program fails it proposes a 

manual selection of the files. 

The status column provides information on the presence or absence of observation and 

navigation files (particularly when a project is loaded from memory).  

You can view the chart of occupation of the files and with the command Occupation chart 

(s) and by clicking the View the network project  command, you will see the graphic 

representation of the project (to obtain this representation, the program automatically 

activates the option to display the fieldbook scheme, which can always be deactivated, par. 

2.5.4). 

By clicking on the Add observation to saved project button, you can include a previously 

saved project to the current one, this guarantees the possibility of building a project that is 

extended over time. 

At the bottom (Figure 6.21), it will be necessary to confirm whether the value relative to the 

antenna height and reported in the RINEX file, has been recorded at the base of the antenna 

or at the phase center. This choice is necessary and must be made with care so as not to 

invalidate the subsequent calculations. 

By clicking on a row of a base or a baseline, through the pop-up menu you can access the 

configuration screen of the calculation parameters, add observation files to the calculation, 

delete the selected base or baseline and you can replace the files of navigation. By clicking 

on the row of a base it is also possible to access the screen relating to its coordinates, a 

screen similar to the one shown in Figure 6.4. 

The post-processing analysis is performed with the default parameters (15 ° as cutoff, 3 as 

minimum coefficient ambiguity ratio and 15 as minimum SNR threshold). To modify them, 

just click on the line of a baseline and select Calculation mode/Satellites. Attention: to assign 

a different analysis configuration to all the baselines you must tick the Assign this calculation 

mode to all the baselines, at the bottom-left of the window, in Figure 6.23. Then confirm (or 

cancel) to continue. 

Performs calculation (Figure 6.21), opens the screen in Figure 6.22, where it will be possible 

to control the project to verify which are the reference points and which points to calculate, 

the purpose of this control is to change the state of the points, if it is incorrect. Pressing Next 

you can start the calculation at the end of which a screen will be displayed as in Figure 6.24. 

The table in Figure 6.24 presents detailed information on the results obtained as follows: 
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Correct coordinate: computed position 

State: solution type (Fixed/Float) 

Satellites: number of satellites used in the computation 

StDev: Standard deviation of the solution 

Measured coordinate: position estimated by the receiver 

Raw differences: differences between estimated and computed position 

At the end of the calculation the possible choices are to save the project with the *.cubemgr 

extension (to which later other calculated points can be added) or export a text file or 

view/save a report in html format. 

 

 

 
Figure 6.19 
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Figure 6.20 
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Figure 6.21 
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Figure 6.22 

 
Figure 6.23 
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Figure 6.24 
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6.5 GNSS network adjustments 

 

This calculation is a statistical evaluation of the quality of a network, is based on the results 

of static post-processing and is used when there is a need to check the position of some 

points over time with high precision. It is accomplished by having more than one base and 

simultaneous observations, that can generate a redundant system. Redundancy allows you 

to observe residual errors that are connected to the sources of error in the measurements 

and cannot be completely removed. 

Residual errors can be divided into random errors and blunder errors. Random errors can 

only be minimized while blunder errors can be detected and eliminated. 

The calculation can be started having in the current Cube-manager project points calculated 

from multiple bases and simultaneous observations. 

The Network command starts with a screen (Figure 6.25) which presents two tables: the 

bottom one shows the baselines with variance values, the top one shows the construction 

of the project, with the bases of reference and the points calculated. The above table offers 

the possibility to redefine the type of point with a drop-down menu (Figure 6.27). 

The Post-processing Project command opens a window as in Figure 6.28, from here you can 

verify the structure of the project and check if for the points the observation files are 

available (the green boxes would appear red and give the possibility to enter manually the 

file), this function has value in case you recall from the memory a *.cubemgr project and you 

want to continue to include points in the project (the observation files may not be in the 

same folder as when the project was saved). 

In Figure 6.28, clicking on the Create project button you can access the screen already 

encountered in Figure 6.21, from here you can insert new bases and baselines to the current 

project, as it was described in the paragraph concerning the static calculation with multiple 

bases, and execute calculation again (it will be necessary to save the *.cubemgr project and 

press the Network command again to return to the network adjustments calculation). 

 

Returning to the screen in Figure 6.25, before performing the actual calculation (Calculate 

network command), you can select the Data snooping, in this case the report created for the 

calculation will present, in the lower part, a table with the critical points, highlighting in red 

the elements out of the given reference factor (non-modifiable standard value). The button 

on the left called Prior Analysis (Loop closure check) will be described in par. 6.5.1 

 

By clicking on Calculation, the report (html file) is automatically created and showed in the 

browser. Returning to the program, you are asked if you want to save the report. Meanwhile, 

the command bar below the tables changes appearance (Figure 6.26), the commands Save 

Job and Report are added. To view the report again, click on Report. The Save Job command 

is used to memorize the calculation’s results. 

Before returning to the main screen, the window in Figure 6.29 will appear, in this window it 

is possible to indicate a name for the calculated fieldbook (by default “netGNSS”) and it is 

possible to access the graphic settings of the error ellipses (Figure 6.30). The error ellipses 

will be drawn on a layer called Ellipse, that can always be hidden. Before the results 
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displaying, the program will present the screen relating to the characteristics of the GPS 

points, par. 2.1.2.12. By deafult, the bases that make up a project are on a hidden layer (can 

be activated); however only in this function, for a better analysis of the results the bases are 

made visible (modifiable option). Furthermore, it is always possible to deactivate the display 

of the baselines (by default deactivated except for these calculations) by deactivating the 

fieldbook scheme command found in the Topography tab, par. 2.5.4.  

Following the GPS features window, you are asked whether to save the current project and 

then the screen for setting the reference system is shown, par. 2.5.2.1. 

 

 
Figure 6.25 

 

 

 
Figure 6.26 
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Figure 6.27 

 

 
Figure 6.28 
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Figure 6.29 

 

 

 

 
Figure 6.30 
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6.5.1 Loop closure 

 

The GNSS network compensation it is enriched with further analyzes and the loop closure. 

To access these functions, simply click on the Prior analysis (Loop closure check) button, 

Figure 6.25. 

In the window in Figure 6.31, you can select what check you want to perform. Each of the 

commands available to the right of the screen generates a report, the first command, 

Analyze control baseline, will automatically show the baselines between known points, if 

they were present in the project, the generated report will be similar to the one shown in 

Figure 6.32. After analyzing and generating the report, returning to the processing window, 

the section on the right in the main window will change appearance as shown in Figure 6.33. 

Here is the selected control baseline (only one in the example), the geocentric coordinates 

of the points, the distance and the error expressed in parts per million (ppm). The red cell in 

the example in Figure 6.33, shows an error above the tolerance that can be set at the top, in 

the PPM Tolerance box. The PPM Calculation command restarts the calculation of the error, 

the Report command opens the report related to the calculation. 

 

 
Figure 6.31 
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Figure 6.32 

 

 
Figure 6.33 

 

Back to the analysis commands (Figure 6.31), the second command from the top, Analize 

repeated baseline, will automatically show the repeated baseline, with a behavior similar to 

that seen in the previous command. 

The Analyze manual loops command generates a window as in Figure 6.34. For this function 

it will be necessary to select the baselines that make up the polygon that you want to analyze. 

The selection can be made from the table on the left in the main window and in which all 
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the project baselines are shown, or by clicking on the Select from drawing button, to access 

the screen in Figure 6.35. 

Baseline selection can be made from the central drawing, by clicking on the baseline or from 

the table on the left, a click highlights the baseline, double-clicking selects it. At the top right 

are the zoom and scale controls to act on the graphic (Figure 6.35). 

As baselines are inserted in the loop, the summary window on the left is populated (the trash 

empties the selections), if the selection generates a loop the program generates a report 

with closure errors. After the automatic creation of the report, a window will appear as in 

Figure 6.37 for saving the report, which can be added at the end of an existing report if 

necessary. 

For the analysis of a polygon (even if not closed) but constrained on known points, it will be 

enough to select the starting baselines and click on the Closure computation. 

If a calculation is made, the appearance of the lower left part of the main screen changes as 

in Figure 6.36, where it is possible to read the total length of the polygon and the closure 

error. 

Returning to the commands in Figure 6.31, the Analyze automatic loops command calculates 

the closure errors of all possible loops, the processing screen will be similar to the one in 

Figure 6.38. In this case you can directly consult the report to check all the calculated loops 

and evaluate the related closure errors. The Closure Computation command allows you to 

recalculate closure errors, a necessary action after a possible modification of the PPM 

tolerance. (The draw polygons command brings you back to the window where to select the 

loops manually, Figure 6.35) 

 

 



 

 

 

 

 

 

Stonex Software Cube-manager v4.3 – User manual           151 

Figure 6.34 

 

 
Figure 6.35 

 

 
Figure 6.36 
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Figure 6.37 
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Figure 6.38 
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7 Tools and controls 
 

7.1 Tools and program commands 

 

Cube-manager supports 2D, 3D and fieldbook view. The windows can be used 

simultaneously, Figure 7.1. 

 

 
Figure 7.1 

 

The fieldbook view allows the management and editing of the surveys (GNSS and TS) present 

in the job. 

On the side summary tree (Figure 7.2), it is possible to insert a new survey and/or new 

elements to the surveys. Depending on the selected node, the program will automatically 

propose a GPS or TS entry. After entering the name (Figure 7.3), the entry will be automatic 

and visible in the grid and in the CAD, if the new element addresses an existing topographic 

point, it will take its coordinates and characteristics, otherwise it will be created with default 

values. 

If you want to add a new survey, you will need to enter, in addition to the name, also what 

kind of survey it is (Figure 7.4). 
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Figure 7.2 

 

 
Figure 7.3 
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Figure 7.4 

 

 On the grid, for the editable columns, you can modify the single values (Figure 7.5) or modify 

the values by selecting multiple rows or cells Figure 7.6 (right-click on the selection). In 

case of multiple selection of more columns, the available functions are those shown in Figure 

7.7. The Rename will act on the elements of the selected lines, the Copy will copy the 

elements and will allow to paste the object only in the fieldbook grid (also on another 

instance of Cube-manager, different from the current, without closing the current). Copy text 

allows a copy of the text value of what is selected in all applications that support the paste 

text function. The command Delete, deletes the selected element or elements. 
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Figure 7.5 

 

 
 Figure 7.6  
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Figure 7.7 

 

The single renaming of an element will make a dialog box appear, like the one shown in 

Figure 7.8, the name change that is being performed is shown at the top, the function to be 

performed must be selected below. Rename the point, will rename all the elements of the 

fieldbook and the topographic points from the starting name to the new name (if the name 

already exists the function will not be completed). 

The second choice, Rename the GPS baseline (the text of the command changes depending 

on which element of the survey is selected), will rename only the element of the selected 

survey, if you insert an existing name the program will ask for confirmation of what you want 

to do as in Figure 7.9, pressing yes the result will be like that obtained with the Rename 

point, by pressing no only the selected element will be renamed and will be linked to the 

existing name element. 

 

 
Figure 7.8 
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Figure 7.9 

If you rename a station from a TS survey, it will be necessary to rename manually the 

measurements you want to connect to the renamed station (created), the program will 

always generate a warning message. 

 

The edit value of multiple selection (Figure 7.6), opens a window as in Figure 7.10, on the 

left you can choose what type of operation you want to perform and on the right you can 

enter the value. 

The modification of the East, North, and Elevation coordinates of an unknown point requires 

its transformation into a known point. 

 

 
Figure 7.10 
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List of commands that can be typed in the command line (Figure 7.11) of the program, the 

recognition of the commands is not case-sensitive: 

 

 

 

Command Description 

OPEN Opens projects (Cube-manager files with extension *.cubemgr, 

the program also supports Cube-link files with the extension 

.cubelnk) 

SAVE Saves the project (with extension *.cubemgr for a normal file, 

with extension .cubemntl for a template file) 

NEW New project 

DXFIN Imports dxf/dwg files 

ASCIIIN Imports generic ASCII files 

SHAPEIN Imports Esri Shape files 

RW5IN Imports RW5 files 

CUBEAIN Imports Cube-a files 

GEOGISIN Imports GeoGis files 

MAPWWW Creates a map 

SENDCAD Opens the project in AutoCAD 

DXFOUT Creates dxf/dwg files 

KMLOUT Creates a KML file for Google Earth 

CUBEAOUT Exports a Cube-a file 

RW5OUT Exports a RW5 file 

GEOGISOUT Exports a GeoGis file 

SHAPEOUT Export in ESRI Shapefile format 

SETDBDATA Creates database for GeoGIS 

PRINT Prints the drawing 

COPYCLIPBOARD Copies CAD entities to clipboard 

PASTECLIPBOARD Pastes the CAD entities from clipboard 

SETTINGS General program settings 

QUIT Closes the program 

2DVIEW Enables 2D view 

3DVIEW Enables 3D view 

ZOOMLI Zoom limits 

ZOOMIN Zoom in 

ZOOMOUT Zoom out 

ZOOMWI Zoom window 

ZOOMPT Zoom on topographic point 

DYNPAN Activates dynamic pan 

ZOOMMA Enables/disables zoom window 

AERIALVIEW Enables/disables the panoramic view 
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POINT Draws a point at the selected location 

LINE Line on 2 points 

CIRCLE Circle with choice of options 

CIRCLECE Center and radius circle 

CIRCLE3P 3-point circle 

CIRCLE2P 2-point circle 

CIRCLETTR Tangent, tangent and radius circle 

ARC Enables arc design options 

ARC3P Arc on 3 points 

ARCCE Arc center, radius, beginning and end 

ARCBE Arco beginning, end and radius 

POLYLINE Draws polylines 

RECTANGLE Draws a rectangle 

POLYGON Draws a regular polygon 

ELLIPSE Draws an ellipse 

3DFACE Draws a 3D face 

HATCH Draws hatch 

SLOPEHATCH Draws slopehatch 

DYNTEXT Starts command to enter dynamic text 

COPYSERIES Draws series of CAD entities 

CREATEBLOCK Creates block with CAD entities and topographic points 

IMPBLOCK Imports block created with Cube-manager 

TEXT Starts command to enter multiline text 

DELETE Deletes CAD entities 

MOVE Moves CAD entities 

COPY Copies CAD entities 

ROTATE Rotates CAD entities 

OFFSET Offset of the CAD entity 

JOIN Connects entities 

FILLET Connects with arc 

EXTEND Extends an entity to the limit 

TRIM Trims entities 

BREAK Breaks entities 

GROUP Groups CAD entities 

UNGROUP Ungroups CAD entities 

EXPLODE Explodes complex CAD entities 

PROPERTIES Modifies the properties of CAD entities 

COPYPROP Copies properties from a CAD entity 

DRAWINGORD Changes view order 

FOREORDER Brings to foreground 

BACKORDER Sends to background 

INSPTONPOLY Inserts polyline vertex or profile vertex 
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DELPTONPOLY Deletes a vertex from a polyline or a profile 

MERGEPOLY Joins two polylines into a single polyline 

POLYINHEIGHT Sets all the vertices of a polyline to a set height 

LAYER Opens the layer properties manager window 

LAYERFROMENT Activates layer from entity properties 

CURRLAYER Moves on current layer the selected entities 

ISOLALAYER Isolates the layers of the selected entities 

LAYEROFF Turns off the layers of the selected entities 

LOCKLAYER Blocks the layers of the selected entities 

LAYERONOFF Turns the current layer on or off 

ALLLAYERON Enables all layers 

UNLOCKLAYERS Unlocks all layers 

VIDEOTHICK Displays video thicknesses 

SYMBOSNAP Sets the osnap symbol size 

ROTAXES Sets the cursor axes rotation 

AXESSIZE Sets the cursor axes size 

VIDEOSCALE Scales the video display 

GRAPHICBGROUND Sets the background color of the graphic window 

CURSORINFO Sets dynamic information on the cursor (values from 1 to 7) 

ORTHO Enables/disables Ortho 

OSNAP Enables/disables osnap 

NEWPT Creates new topographic point 

CHARACPT Creates topographic points from CAD entities 

PTPROP Displays (changes) properties of the topographic point 

PTTABLE Displays topographic points table 

MEANCENT Averages the coordinates of nearby points 

RENAMEPT Renames topographic point 

PTOFFSET Edits point-to-text offset 

R1PLUS Imports a fieldbook from a file with .dat or .r15 extension 

R2LPLUS Imports a fieldbook from R2L Plus / R25 file 

R2/R2SPLUS Imports a fieldbook from R2S Plus file 

R2WFG Imports a fieldbook from Fieldgenius file 

R2WSC Imports a fieldbook from SurvCe/RW5 file 

R2WAM Imports a fieldbook from AntasMobile file 

EXPR1PLUS Exports coordinates in R1 Plus file format 

EXPR2PLUS Exports coordinates in R2 Plus file format 

EXPR2LPLUS Exports coordinates in R2LPlus file format 

EXPR2PLUSRAW Exports coordinates in RAW file format 

EXPR2PLUSRW5 Exports coordinates in RW5 file format 

EXPR2WCSV Exports coordinates in AntasMobile file format 

EXPGSI16 Exports coordinates in GSI 16 bit file format 

EXPGSI8 Exports coordinates in GSI 8 bit file format 
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NEWFIELDBOOK Opens a window where to create a new fieldbook 

OPENFIELDBOOK Imports an existing fieldbook 

LOADFIELDBOOK Imports a fieldbook in one of the supported formats 

FROMFIELDBOOK Reads fieldbook presents in the project 

DOWNLOADLEVELING Downloads data from digital level 

TRANSLATEPTS Opens the window where you can translate points and 

exchange coordinates 

PTTOGPS Performs GPS stakeout 

PRESETSYSTEM Sets default reference system 

ADDNEWSYSTEM Creates new reference system 

DELETERASTER Deletes raster image 

PPSTOPGO Opens the window in which to perform postprocessing 

Stop&Go 

PPSTATIC Opens the window in which to perform Static postprocessing 

PPKINEMATIC  Opens a window in which to perform Kinematic postprocessing 

PPSTATICNET Opens a window in which to perform Static Multi-Base post-

processing 

GPSNET Opens a window to perform GNSS network compensation 

RASTERIN Import raster image 

CALCULATION7PARAMETERS Opens a window for the 7 parameters calculation 

COORDINATECONVERSION Opens a window for the coordinate conversion 

TRIGONOMETRICLEVEL Allows to import a file for leveling 

GEOMETRICLEVEL Allows to import a file (.csv) for leveling 

CREATECURVE Opens a window to create contour lines 

CREATEDTM Opens a window to create a DTM 

CONSTRAINTBOUND Allows the creation of a constraint 

EXCLUSIONBOND Allows the creation of an exclusion  

EXISTINGPROFILE Allows to import a file with the .cubeprf extension 

MANUALPROFILE Allows to create a manual profile 
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Figure 7.11 

 

Another useful tool besides the command line is the Quick Selection (Figure 7.12); in the 

commands that involve the selection of CAD entities or topographic points, with the right-

click it is possible to access a menu that allows a quick selection of the entity/entities. The 

selection is divided into topographic point and CAD entities and takes place through the 

choices of the respective properties. From this pop-up window (right-click) it is also possible 

to quickly access the properties window of the entity. 

 

 
Figure 7.12 
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Double-clicking on the mouse wheel performs a zoom limit. 

 

The Project management panel (Figure 7.13, on the left of the main screen) is a tree structure 

that contains all the topographic and raster entities present in the project. By double clicking 

on the topographic points, you can select them as an alternative to the graphic selection. 

The icons next to the name provide information on the type of point in question. 

 

 

 
Figure 7.13 

 

The Project management panel can be activated or deactivated by pressing the show / hide 

button at the bottom-left part of the main screen (icon in the red circle, Figure 7.14). While 

the two icons to the right of the command line have the function to start the system 

calculator (first icon from the left) and opening a file with the date, time and description of 

the commands entered in the current work session (second icon). 

 

 

Figure 7.14 

 

At the bottom of the screen, you can view the coordinates of the elements in the project, 

enable or disable the Osnap mode, the Ortho view and the Polar view. Thicknesses and 

reference grid can also be activated or deactivated.  
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Activating the Reference grid generates a window as in  Figure 7.15. In this screen it is 

possible to create the ref grid by defining the type and scale at the top. In the main panel, 

the construction values of the parameters can be set (default values are always available), at 

the bottom you can set whether to build an external frame and with what characteristics. 

The Frame captions command opens a screen as in Figure 7.16, where you can choose the 

characteristics of any writes. By pressing the Reference grid button in the main interface, you 

can deactivate it (if a ref grid is found in the active job, you can delete or deactivate it, or 

create a new one). 

 

 
Figure 7.15 
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Figure 7.16 

 

By clicking on the Tool bars button (menu in the red circle, Figure 7.17) it is possible to 

customize the layout and display of the shortcuts available in the program (Figure 7.18, all 

the icons for the shortcuts available. To relocate them on the screen, drag the bars by clicking 

on the 5 points on the left, drag-and-drop system). 

 

 
Figure 7.17 
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Figure 7.18 
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